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Introducing Corel® Digital Studio™ 2010

For the first time on the PC, Corel® Digital Studio™ 2010 brings together photo, 
video, DVD burning and playback within a single, consistent user interface that 
makes it simple for anyone to get amazing results. 

With this digital media suite, it is now possible for anyone to organize all of 
their digital media in one place, effortlessly enhance photos, and turn their 
video clips into movies in just minutes. Leaving complicated jargon and processes 
behind, Corel Digital Studio 2010 simplifies working with photos and videos on 
the PC.

Optimized to take full advantage of all of the time-saving features and ease of 
use of Windows® 7, Corel Digital Studio 2010 is the easiest photo, video and 
DVD-burning software you’ll ever use. 

Digital media for everyone

Today, millions of consumers use their point-and-shoot digital cameras and 
mobile phones to capture photos and video clips of all kinds of events — from 
special occasions to the everyday details of their lives.

In recent years, these camera users have become proficient at taking digital 
photos and performing basic photo-editing tasks. They print their photos at 
home or in stores, e-mail photos to friends and family, and post photos to 
Facebook™ or online photo-sharing sites. Consumers are also using their cameras 
to take video, but so far, very few are actually doing anything with these clips. 
Why is this?

The answer is simple: Consumers see video editing as too difficult and time-
consuming. And until now, they’ve been right.

Corel has reassessed the way people work with their digital media — not just 
video, but photo, burning, sharing, and creative tasks, too. Corel Digital 
Studio 2010 offers a new approach that finally makes it simple for anyone to 
work with photos and videos on the PC.



Reviewer’s Guide [ 2 ]

Customer profile

Families have become an important segment of the digital media market. Even 
though taking, organizing and editing photo and video content can be a fairly 
technical process, widespread adoption of affordable point-and-shoot cameras 
and camcorders has brought digital media to the mainstream. All around the 
world, families and friends are using their point-and-shoot cameras and mobile 
phones to capture the milestone — and the everyday — moments in their lives.

Corel has specifically researched these customers to understand their motivation 
and wish list when using consumer digital media software. The average digital 
media consumer is busy and doesn’t have the time or desire to master a 
complicated software application. Consumers want to quickly and easily create 
and share a stunning project. And they want the process to be fun.

Corel Digital Studio 2010 has been specifically designed to remove the 
complexity of working with digital media, so users who may not consider 
themselves to be technologically savvy can feel confident and inspired to turn 
their photos and videos into lasting projects.
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What’s included?

Applications

• Corel® VideoStudio® Express 2010: This breakthrough video-editing 
software is built on the technological foundation of Corel® VideoStudio® 
Pro, offering a streamlined interface and tools that empower anyone to 
quickly create professional-looking movies, slideshows, and DVDs. The 
QuickCut Timeline and simple editing tools make it easy to improve video 
clips. In a few clicks, a collection of video clips can be assembled into a 
polished movie. Users can easily share movies with family and friends on 
DVD or portable devices, such as iPods® or mobile phones, or by uploading 
directly to YouTube™.

• Corel® PaintShop Photo™ Express 2010: Based on the acclaimed features 
of Corel® Paint Shop Pro® Photo and offering a simplified workspace, this 
application helps digital camera users create great-looking photos in a few 
simple steps. Photos can then be uploaded to Facebook and Flickr™ or used 
to make photo books, calendars, and more. Photo management features 
take the guesswork out of finding that special image. One-step photo 
corrections remove the most common digital photo imperfections in a 
couple of clicks. Corel® PaintShop Photo™ Express 2010 also has a wide range 
of photo-sharing options.

• Corel® WinDVD® 2010: Bringing the theater experience to the PC, 
Corel® WinDVD® 2010 plays both DVDs and video files. Viewers can 
experience home movies or the latest Hollywood blockbuster with 
impressive sharpness, color, and audio. Corel WinDVD 2010 is optimized for 
video playback on laptops and can play video clips directly from cameras and 
camcorders.

• Corel® DVD Factory™ 2010: This application enables the creation of 
professional-quality DVDs from photos and videos. In addition, 
Corel® DVD Factory™ 2010 allows users to back up their digital media content 
easily to CD or DVD, protecting their precious memories. It also enables users 
to easily export digital content to mobile devices, record TV shows, and 
import photos and video clips from digital cameras, camcorders, set-top DVD 
recorders, and mobile phones.

• Corel® Instant Viewer™: This component provides a quick, direct way to 
view photos on a PC. Users can scroll through photos and send them to the 
Express Edit view in PaintShop Photo Express 2010 to perform easy 
touch-ups.

• Corel® Digital Studio Gadget™: Located on Windows 7, Windows Vista®, 
and Windows® XP desktops, the Corel® Digital Studio Gadget™ launches 
automatically on computer startup, enabling users to start any of the 
applications in Corel Digital Studio 2010.
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System requirements

• Intel® Core™ Duo T2400 1.83 GHz, or AMD Athlon™ 64 X2 3800+ (2.0 GHz or 
higher recommended)

• Microsoft® Windows® 7, Windows Vista®, or Windows® XP with latest service 
packs installed

• 1 GB of RAM (2 GB or higher recommended) 

• 128 MB of VGA VRAM or higher (256 MB recommended)

• 4 GB of free hard-drive space

• 1024 × 768 minimum display resolution

• Windows®-compatible sound card

• Windows®-compatible DVD-ROM for installation

• Recordable DVD drive for creating DVDs

• Internet connection for online features

Input/Output device support

• 1394 FireWire® cards for use with DV/D8/HDV camcorders

• Support for OHCI Compliant IEEE-1394

• Analog capture cards for analog camcorders (VFW & WDM support for 
Windows XP and Broadcast Driver Architecture support for Windows Vista)

• Analog and digital TV capture device (Broadcast Driver Architecture support)

• USB capture devices, PC cameras, and disc/memory/hard-drive camcorders

• Windows®-compatible Blu-ray, DVD-R/RW, DVD+R/RW, DVD-RAM, and 
CD-R/RW drive

• Apple® iPhone™, iPod® with video, Sony® PlayStation® Portable, Pocket PC, 
smartphone, and Nokia® mobile phone

Input format support

• Video: AVI, MPEG-1, MPEG-2, HDV, AVCHD™, M2T, MPEG-4, H.264, 
QuickTime®, Windows Media® Format, MOD (JVC MOD File Format), M2TS, 
TOD, BDMV, 3GPP, and 3GPP2

• Audio: Dolby® Digital Stereo, MP3, MPA, QuickTime®, WAV, and Windows 
Media® Format

• Images: BMP, JP2, JPC, JPEG, PNG, TGA, TIFF/TIF, GIF, RAW, and PSPImage

• Disc: DVD-Video, DVD-VR, and AVCHD™

Output Format Support
• Video: DV AVI, MPEG-2, MPEG-4, H.264, QuickTime®, Windows Media® 

Format, 3GPP, and 3GPP2
• Images: BMP, JPEG, GIF, PNG, and TIF/TIFF

• Disc: DVD (DVD-Video/DVD-VR/AVCHD) 

• Media: CD-R/RW, DVD-R/RW, DVD+R/RW, DVD-R Dual Layer, and DVD+R 
Double Layer
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Suite-wide features in Corel® Digital Studio™ 2010

Now that most digital cameras and mobile phones can capture video as well as 
photos, the once separate workflows for photo and video are converging. 
Corel Digital Studio 2010 is the first digital media suite on the PC that reflects 
this new reality, bringing photo, video, audio, and playback together into a 
single, consistent user experience. The tasks of organizing, editing, burning, 
playing back, and creating projects are greatly simplified by the suite’s common 
look, feel, and functionality.

There’s no hunting for features in Corel Digital Studio 2010. Whether the task at 
hand is editing video, creating a photo book, or burning a project to disc or 
device, the tools for common tasks are located in the same place on-screen. 
After learning how to organize and edit photos, users can apply those skills to 
working with videos or vice versa.

Corel Digital Studio 2010 organizes content by album, and users can include an 
individual picture or video clip in multiple albums. Family memory-keepers can 
always feel secure knowing that they can revert back to their original file at any 
time when editing or creating projects.

Here are some of the suite-wide features in Corel Digital Studio 2010 that help 
users import, organize, enhance, and share photos, videos, and audio files.

Capturing and enhancing life’s memories

Windows® 7 compatibility: Designed to make everyday tasks faster and 
easier, Windows 7 promises to change the way PC users work. Corel Digital 
Studio 2010 is built to take advantage of all that this new operating system 
offers, with full Windows 7 optimization. Key Windows 7 features in Corel 
Digital Studio 2010 includes support for Jump Lists, providing fast and easy 
access to recently used features, tools, and content. Windows 7 Libraries make 
managing files a breeze by collecting related content regardless of where those 
files are stored. In addition, new battery optimization capabilities ensure 
users can work on projects or watch movies on their laptops longer than ever 
before. And for customers using the latest Windows Touch-enabled hardware, 
the addition of Windows Touch support adds an entirely new, hands-on 
experience when working with their digital content.



Reviewer’s Guide [ 6 ]

Windows Touch: With Windows Touch, Corel Digital Studio 2010 lets anyone 
with a touch-screen PC literally get hands-on with their videos, photos, and 
creative projects.
Here are just a few ways users can get “in touch” with their digital assets:

Corel Digital Studio 2010 and Windows Touch 
offer a more natural and hands-on creative environment.

Intuitive user interface: The applications in Corel Digital Studio 2010 have 
similar workspaces and workflows, so concepts learned in one program are 
easily transferred to another.

Put both fingers on the content, and pinch/stretch to 
zoom in or out.

Touch to select content, and drag it to a new location.

Rotate content with two fingers.

Flick to scroll, move content to the Media Tray, or 
browse the Media Tray.

Tap any button to activate it.

Display a right-click menu by touching the screen and 
holding for three seconds.
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Media Organizer: The hub of the suite is the Media Organizer, where users 
can quickly search for and access all of their media files from one location. The 
Media Organizer automatically filters media content, giving prominence to files 
that are most relevant to the active application.

Users can also apply tags, descriptive words that categorize content, to files so 
digital media is easier to find and group. A zoom slider allows for a closer look at 
photos and videos. File information, such as the date it was created and its 
location on the PC, displays when the mouse pointer is positioned over a file 
thumbnail.

Double-clicking a file launches the Express Edit mode, where quick touch-ups 
can be easily performed. The Media Tray, located at the bottom of the Media 
Organizer, is a single convenient location for all files that are being worked on, 
shared, printed, or used in a project.

Hassle-free media import: Corel Digital Studio 2010 takes the guesswork 
out of importing media files from a range of devices, including digital cameras, 
camcorders, memory cards, and mobile phones.

Corel Digital Studio 2010 makes importing digital content a breeze.

Corel® Guide: Always accessible on the application bar, the Corel® Guide offers 
learning tools, additional content, and free trial software. Corel Guide can be 
launched at any point in a project workflow. The Corel Guide can be set to 

Give it a try
To import media from a device

1 With a Corel Digital Studio 2010 application running, plug a device 
into your PC.

The device is automatically detected.

2 In the dialog box that appears, click Yes.

3 Select the media files to be imported from the device, and click 
Import. 

The folder appears in the work area and is listed in the navigation 
pane.
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automatically update content, so the latest learning tools and project templates 
are always accessible.

The Corel Guide provides access to additional help, content, and Tips & Tricks.

Turning photos and videos into amazing creations

Polished creative projects: Special moments captured in photos and videos 
are most meaningful when they’re shared. Corel Digital Studio 2010 offers tools 
and features for turning memories into a range of impressive creations, 
including great-looking movies, photo books, greeting cards, collages, and 
calendars. In addition, double-clicking an image or video clip in a creative 
project or movie launches Express Edit without disrupting the workflow. When 
the editing is complete, the project workflow picks up where it left off.

Protecting and sharing life’s memories

Content backup: Corel Digital Studio 2010 offers peace of mind by enabling 
users to easily back up important digital content to DVD, Audio CD, or data disc. 
For more information, see “Easy digital content backup” on page 28.

Effortless export to e-mail, Web, or device: Corel Digital Studio 2010 
simplifies sharing digital content. In a couple of clicks, photos and videos can be 
uploaded to YouTube, Facebook, or Flickr. When e-mailing photos and 
videos with Gmail™ or other e-mail programs, media files can be resized and 
resampled. Users can even take their content on-the-go with easy file transfer to 
mobile phone, iPod, iPhone™, or their favorite mobile device.

Give it a try
To launch the Corel® Guide

1 Click the Corel Guide icon .

2 Click Home to get an introduction to the Corel Guide.

3 Click Learn to get access to help and learning tools.

4 Click Messages to view an archive of all messages and updates.

5 Click Launch Help to access more detailed help.
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Corel® VideoStudio® Express 2010 key features

With a groundbreaking approach to importing, managing, editing, and sharing 
videos, Corel VideoStudio Express 2010 is designed for PC users who may have 
found working with video too difficult and time-consuming in the past. A new, 
simple interface and breakthrough technology allows everyone to quickly do 
more with their video clips.

Capturing and enhancing life’s memories

Easy video import: VideoStudio Express 2010 automatically detects cameras, 
camcorders, and memory cards, and imports video clips to folders in the Media 
Organizer. Media clips can be further organized into custom albums, making 
them easy to find and use in creative projects.

Intuitive video organization: The Media Organizer makes video previewing 
and organizing a breeze. Home videographers can easily access their video clips 
by viewing thumbnails, searching by tag, caption, name, folder or album, as well 
as sorting them by name, date, or rating. By simply right-clicking on a video clip, 
users can choose to e-mail it, upload it to YouTube, or view it in WinDVD 2010. 

The Media Organizer simplifies video and media management.
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Express Edit: VideoStudio Express 2010 makes basic video editing a snap — 
even for novices. Double-clicking a video clip at anytime launches the Express 
Edit mode, where videos can be quickly improved and unwanted clips can be 
deleted. In seconds, videos can be trimmed, split, and enhanced all within the 
same view. Users can give their video clips a one- to five-star rating, so they can 
easily find their favorites when sorting video.

Express Edit helps family videographers quickly produce amazing results. 

Give it a try
To quickly edit a video clip

1 Double-click a video clip in the Media Organizer to launch Express 
Edit.

If you don’t have a video clip in the Media Organizer, click Import, 
and navigate to a folder containing video files. You can also import a 
video clip by plugging a device into your PC, and clicking the Import 
menu.

2 Drag the play head  on the QuickCut Timeline to choose where you 

want to trim or split the video clip.

3 Do one of the following:

• Click the Trim video button  to delete part of the clip. 

• Click the Split video button  to split the clip.
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• Advanced editing tools – With a variety of one-click enhancement tools, 
VideoStudio Express 2010 demystifies video editing. Users can choose from a 
variety of white-balance corrections based on the type of lighting used when 
the video was captured. If a clip is spoiled by video noise or camera shake, 
VideoStudio Express 2010 can quickly correct those problems, too.

The More Tools menu simplifies advanced-editing 
tasks like shake correction and brightness adjustment.

Turning memories into lasting creations

Easy movie creation: In a few clicks, VideoStudio Express 2010 can turn video 
clips into polished movies complete with transitions and titles. Choose from a 
range of movie styles that add Hollywood-style openings, pans and zooms, 
closings with credits, and soundtracks — VideoStudio Express 2010 does the rest.

VideoStudio Express 2010 offers a variety of movie styles.

Give it a try
To access more advanced editing tools

• On the right side of Express Edit, click the More Tools panel.
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• Titles – Movies can be customized by adding titles and text. A variety of font 
and placement options help create personalized movies with real impact.

Titles can help personalize a movie.

 • Soundtrack and Voice-over – Aspiring videographers can give their 
movies a documentary feel or add audio commentary by recording a 
voiceover track. If there’s music that would complement a piece of video, 
users can dip into their music library and add a special song.

Users can easily add commentary to their movies.

Give it a try
To create a movie

1 On the Action Bar, click the Create menu, and choose Movie.

2 On the Create Movie page, select a screen format, and type a name for 
the movie in the Project name box.

3 Click Select photos and videos.

4 Drag video clips and images to the Media Tray, and click Go to Movie.

The movie is complete, but you can also customize it by doing any of 
the following: 

• To change the movie style, click the Styles tab, and choose a 
definition format and a movie style.

• To add a title, click the Titles tab, and drag the play head on the 
QuickCut Timeline to the spot in the video where you would like to 
add the title. Select a title style, double-click the title box that displays, 
and type a title. You can adjust how long the title displays by dragging 
the handle on the caption box.
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Sharing special moments — effortlessly

YouTube™ upload: If users have a YouTube account, they can upload videos 
directly from VideoStudio Express 2010. If they don’t, they can create a YouTube 
account and start sharing their video in no time. The Smart Upload feature 
remembers YouTube account information and uploading preferences, making 
future uploads even faster.

In addition, if a piece of video exceeds YouTube file size and time limits, 
VideoStudio Express 2010 automatically splits the clip into sections that meet 
YouTube standards.

YouTube account settings can be saved to upload videos faster.

• To change a soundtrack, click the Soundtrack tab, position the 
mouse pointer over the audio file thumbnail, and click the delete 

button . You can add another audio file by clicking Browse my 

music, selecting the file, and clicking Add.

• To add a voiceover track, click the Voice-over tab, drag the play 
head on the QuickCut Timeline to the spot in the video where you 
would like to start the voice-over. Click Start recording, record the 
voice-over, and click Stop recording.

5 Click Output Movie.

You can export the movie to a mobile device; save it as a file; upload it 
to YouTube, Facebook, or Flickr; e-mail it to friends and family; or burn 
it to DVD.

Give it a try
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In a few simple steps, videos can be also uploaded to Facebook or Flickr. 

Express Burn to DVD: Once a movie project is complete, VideoStudio 
Express 2010 offers effortless DVD burning, making it easy to watch home 
movies on TV, share them with friends and family, or back them up for posterity. 
Users can quickly burn their movie to DVD with a default menu template, or 
they can select the Customize Menu option to open their project in DVD Factory 
2010 to customize the DVD menu style and add chapters. For more information, 
see “To create a DVD menu” on page 30.

Burning home movies to DVD is quick and easy.

Give it a try
To upload a video to YouTube™

1 On the Action Bar, click the Share menu, and choose YouTube.

2 Drag a video clip to the Media Tray, and click Upload to YouTube.

3 On the Upload to YouTube page, type your user name and password, 
and click Next.

You can create a YouTube account by clicking Sign up to YouTube.

4 Click Next.

5 Add a title, description, and tags for the video.

6 Choose a category for the video.

7 Click Upload.
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5
Corel® PaintShop Photo™ Express 2010 key features

Corel® PaintShop Photo™ Express 2010 gives family photographers everything 
they need to quickly organize, enhance, and share their photos. Users can also 
create a wide variety of amazing photo projects.

Capturing and enhancing life’s memories

Easy photo and video clip importing: PaintShop Photo Express 2010 can 
easily import content from cameras, memory cards, mobile phones, and external 
hard drives to the Media Organizer.

Intuitive photo organization: The Media Organizer makes photo and 
media organization a breeze. Digital photographers can quickly access photos by 
viewing thumbnails, searching for images by caption or name, or viewing them 
by album, folder, date, or rating. Tags — descriptive words that categorize 
pictures — can be used to easily identify and group photos.

Clicking the Quick Show button launches a full-screen slideshow of all or 
selected sets of photos in the Media Organizer. Users can also switch views at 
any time to see all of their digital media, as well as launch the application or 
editing tools best suited for that file.

The Media Organizer simplifies photo management.
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Corel® Instant Viewer™: When selected as the default image viewer, the Corel 
Instant Viewer is a quick and easy way to view and touch-up photos. Double-
clicking a photo in Windows Explorer, in an e-mail, or on the desktop launches 
the Corel Instant Viewer. It enables family photographers to scroll through 
photos, rotate them, and send them to the Express Edit mode in PaintShop 
Photo Express 2010 for editing.

The Corel Instant Viewer offers one-click access to PaintShop Photo Express 2010.

Express Edit: Double-clicking an image in the Media Organizer launches the 
Express Edit mode, where users can scroll through their photos, make quick fixes, 
apply effects, and delete pictures that didn’t turn out.

• One-click photo rating – Family photographers can assign ratings to their 
photos with a single click, so they can quickly find their favorites when 
sorting images. Other tools are also located around the perimeter of the 
photo window for rotating, saving, printing, and e-mailing images. In 
addition, users can add captions to their images and display them in a full-
screen view.

As users go through their photos, they can give them a rating of 1 to 5 stars.
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• Media Tray – Family photographers can click the Previous or Next buttons 
to scroll through images in the Media Tray and quickly enhance, share, or 
delete photos.

• Common Tools bar – Located above the photo window, the Common Tools 
bar enables users to easily perform common photo edits, such as red-eye 
correction, image straightening, and cropping. The Quick Fix tool gets great 
results in a snap by analyzing the image and performing the correction in a 
single click.

The Common Tools bar simplifies basic photo-editing tasks.

• Easy access to more tools – By clicking the More Tools panel, users can 
access tools for touching up photo subjects, fine-tuning image settings, and 
enhancing photos with a collection of professionally designed artistic 
elements. A range of photo edges and frames are also available for giving 
favorite images a special look and feel. In addition, a variety of photo filters, 
including black-and-white and sepia, can send photos back in time.

Users can access more image-enhancing tools that 
allow them to take their photos to the next level.

The Makeover Tools improve how subjects in a photo look. The Toothbrush 
quickly whitens discolored teeth, the Suntan Brush adds color to pale, 
washed-out skintones, and the Blemish Fixer can remove over blemishes.
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Turning photos into lasting creations

Creative photo project designs: With dozens of professional designs for 
creating stunning calendars, greeting cards, and collages, PaintShop Photo 
Express 2010 helps maximize the potential of anyone’s digital images. To share 
creations, users can print projects at home or easily upload them to a 
professional printing service (Note: Online printing services are available in 
select countries only and subject to additional charges). In addition, double-
clicking an image in a creative project launches Express Edit without disrupting 
the workflow. When the editing is complete, the project workflow picks up 
where it left off.

Creating photo projects like calendars is easy in PaintShop Photo Express 2010.

Give it a try
To create a calendar

1 On the Action Bar, click the Create menu, and choose Calendar.

2 On the Create Calendar page, select a calendar style.

3 Set the calendar start date.

4 Click Select photos.

5 Drag a photo album to the Media Tray, or select photos from multiple 
albums.

A counter at the top of the Media Tray indicates how many photos 
you’ve chosen and how many are required for the calendar template 
you selected.

6 Click Go to Calendar.

The calendar is complete, but you can also customize it page-by-page 
by clicking the Styles, Layout, or Background tabs and choosing 
from a variety of options.
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Professional-looking photo books: Photo books are the perfect way to 
showcase precious memories, especially if they’re professionally printed and 
bound. Uploading photos to an online printing service, however, can be time-
consuming and frustrating. In PaintShop Photo Express 2010, users simply choose 
a photo book style and select photos to create an eye-catching photo book. 
Then, they can order a professionally printed book in a few easy steps. 

PaintShop Photo Express 2010 makes creating photo books a snap.

You can view the entire calendar and reorder photos by clicking the 

View all pages button  and dragging images.

7 Click Output Calendar.

You can save the calendar as a PDF or a series of JPEG images, e-mail it, 
print it at home, or order a professionally printed version online.

Give it a try
To create and print a photo book

1 On the Action Bar, click the Create menu, and choose Photo Book.

2 On the Create Photo Book page, type a name for the project in the 
Project Name box.

3 Select a photo book style.

4 Click Select photos.

5 Drag a photo album to the Media Tray, or select photos from multiple 
albums.

A counter at the top of the Media Tray indicates how many photos 
you’ve chosen and how many are required for the photo book 
template you selected.

6 Click Go to Photo Book.

Give it a try
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Slideshows made easy: Photos and videos look great combined in a 
slideshow. PaintShop Photo Express 2010 makes this fast and fun by enabling 
users to easily tailor the look and feel of their slideshows by adding soundtrack 
music or choosing from a variety of slide transitions. When it comes time to 
share their creation, they can burn it to DVD, save it to a video file, or upload it 
to YouTube, Flickr, or Facebook. Slideshows can also be automatically resized for 
easy e-mailing.

Especially handy for tweaking a video clip destined for a slideshow, double-
clicking a video file launches the Express Edit mode. When the editing is 
complete, the slideshow workflow picks up where it left off.

The photo book is complete, but you can also customize it page-by-
page by clicking the Styles, Layout, or Background tabs and 
choosing from a variety of options.

You can reposition a photo within its frame by clicking the photo to 

display a toolbar, clicking the Pan Photo button , and dragging. 

You can expand a photo by dragging the Zoom slider .

You can view the entire photo book and swap photos from page to 

page by clicking the View all pages button  and dragging 

images. 

7 Click Output Photo Book.

8 Click Order Online.

Online printing services are available in select countries only and 
subject to additional charges

9 Choose a color and material for the photo book cover, and click Start 
Upload.

10 Click Check out to complete the order.

Give it a try
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Sharing special moments — effortlessly

Easy uploading: Photos, videos, and slideshows can be shared by uploading to 
sites, including Facebook, Flickr, or YouTube.

Flexible e-mailing: The most popular way to share photos is by e-mail. 
PaintShop Photo Express 2010 enables users to embed or attach photos and has 
file size options that ensure workable e-mail sizes with Gmail or their default e-
mail program. Embedding allows recipients to see photos without the 
annoyance of dealing with attachments.

PaintShop Photo Express 2010 takes the guesswork out of e-mailing images.

Give it a try
To upload photos to Facebook™

1 On the Action Bar, click the Share menu, and choose Facebook.

2 Drag a folder of photos into the Media Tray.

3 Log into Facebook.

4 Click Upload to Facebook.
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Printing creative projects

Online print ordering: PaintShop Photo Express 2010 simplifies online 
ordering of professionally printed photo books, calendars, greeting cards, and 
collages. (Note: Online printing services are available in select countries only and 
are subject to additional charges.)

Creative projects can be sent directly to a professional printing service.

Easy home printing: PaintShop Photo Express 2010 has a variety of options 
for printing multiple photos on a single page.

PaintShop Photo Express 2010 offers a variety of printing options.

Give it a try
To print multiple photos on a single page

1 On the Action Bar, click the Print menu, and choose Photos.

You can set the number of copies of a photo to print.

2 Click the Layout tab, and select a layout format.

You can change print options by clicking the Print Settings panel.

3 Click Print.
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6
Corel® WinDVD® 2010 key features

Corel WinDVD 2010 is video playback software that enables users to watch 
movies on their PC. They can also view their home movies recorded on the latest 
AVCHD™ camcorder without having to transfer anything to their PC.

Reliving life’s memories

Instant preview: As much as reviewing video on a tiny camcorder or digital 
camera screen serves a purpose, it really doesn’t do the clip justice. 
WinDVD 2010 gives users a much clearer picture of what they’ve captured. 
Without having to transfer anything to their computer, they can preview video 
on their PC directly from a storage device, camera, or camcorder.

High-quality playback: WinDVD 2010 offers full-resolution playback quality 
— with Dolby Digital audio up to 5.1 channels and for video formats in standard 
and high definition, including MPEG2 and AVCHD — that brings the movie 
theatre experience to the PC.

Playback from mobile devices: Users can play back videos stored on mobile 
devices, such as an iPod, PlayStation® Portable, or mobile phone.

Video format compatibility: WinDVD 2010 plays the most common video 
formats, including DVD-Video, QuickTime®, Windows Media®, M2T, and M2TS 
support.

Personalized bookmarks: When watching a DVD, stopping playback and 
struggling to locate the last-viewed scene can be very frustrating. WinDVD 2010 
solves this problem by enabling viewers to mark any point on a DVD so they can 
easily pick up where they left off or find a favorite scene.
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Personalized bookmarks help locate favorite scenes.

TimeStretch: Especially handy for watching a movie on a laptop when 
traveling, TimeStretch speeds up DVD playback so that a movie finishes in an 
allotted time.

Give it a try
To insert a bookmark

1 On the Action Bar, click the Tools menu, and choose Bookmarks.

2 Click the Bookmark button  at the point in the DVD where you 
want to insert a bookmark.

A thumbnail displays the frame where the bookmark was inserted. 
Clicking the thumbnail plays the DVD from that point.

Give it a try
To view a DVD using TimeStretch

1 On the Action Bar, click the Tools menu, and choose Enhancements.

2 Click the Time Stretch drop-down menu.

You can speed up playback so that a movie completes at a specified 
time or in an allotted block of time.
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Capture images from DVDs: The capture controls make it easy to grab a 
favorite home movie moment as a photo — or a scene as an animated GIF — 
that can be shared via e-mail or mobile phone. (Note: This feature does not work 
with copyright-protected DVDs.)

WinDVD 2010 has tools for capturing and sharing a movie moment.

Laptop battery optimization: Users can enjoy an entire movie without 
worrying about their laptop running out of battery power. In addition, with the 
battery optimization features of Windows 7, batteries last longer than ever, 
delivering uninterrupted viewing.

Give it a try
To capture an image from a DVD

1 On the Action Bar, click the Tools menu, and choose Capture.

2 Click the Capture button  at any point during DVD playback to 
capture that frame.

A thumbnail displays the frame that was captured as a bitmap.
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7
Corel® DVD Factory™ 2010 key features

With Corel DVD Factory 2010, anyone can create professional-quality DVDs from 
photos and videos and easily back up media files to disc. Users can create 
Hollywood-style animated menus and apply dazzling special effects. In addition, 
DVD Factory 2010 can easily export digital content to mobile devices, record TV 
shows, and import photos and video clips from digital cameras, camcorders, set-
top DVD recorders, and mobile phones. Together with PaintShop Photo Express 
2010 and VideoStudio Express 2010, DVD Factory 2010 offers an intuitive 
solution for creating impressive pan-and-zoom slideshows or turning video clips 
into polished movies with opening sequences, titles, and music.

Capturing, protecting, and sharing life’s memories

TV to DVD direct capture: With DVD Factory 2010, there’s no need for a PVR 
to record TV. If users have a TV tuner on their PC, DVD Factory 2010 can record 
TV feeds directly to DVD so that they can view a favorite program when it suits 
their schedule.

DVD Factory 2010 can capture a TV feed and burn it to DVD.
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DV/HDV to Disc direct capture: Anyone with a digital video camera knows 
how time-consuming it can be to upload video files to their PC. 

DVD Factory 2010 can transfer digital video content directly to DVD, saving time 
and making it easier to work with that video later.

Easy digital content backup: Home PCs and hard drives are now the 
primary archive of precious family photos and videos, but they are much more 
than that. Home computers have become the hub of family life, but they can 
suffer from crashes and vulnerable to viruses. DVD Factory 2010 offers quick 
DVD backup, so users always have a copy of their important photos, videos, 
audio clips, and documents if something happens to their PC.

Effortless DVD burning helps preserve precious memories.

Audio disc creation: DVD Factory 2010 can automatically convert popular 
audio formats and burn to a CD. In addition, users can burn their MP3 music files 
to a CD or DVD, which can store more songs than a standard audio CD and can 
be played in many modern CD and DVD players. 

Users can burn Audio CDs and MP3 discs.

Give it a try
To create a backup data disc

1 On the Action Bar, click the Create menu, and choose Backup Disc.

2 Drag the files to be backed up from the Media Organizer to the Media 
Tray, and click Go to setup.

3 Click Burn.
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Simple DVD duplication: Family memories are so much better when they’re 
shared. To that end, DVD Factory 2010 makes it quick and easy to create a 
duplicate DVD, as long as it is not copy-protected.

Digital content to go: DVD Factory 2010 simplifies moving digital content 
from PCs to a portable device, such as an iPod, iPhone, PlayStation Portable, or 
mobile phone. In a few clicks, videos and audio files can be copied to a portable 
device to be enjoyed and shared anywhere.

Photos, videos, and audio files can be copied to a variety of portable devices.

Turning memories into lasting creations

Personalized DVD menus: After creating a great-looking movie from their 
home videos, users can take it to the next level by adding professional-looking 
DVD menus. They can add chapters just like the ones they see in Hollywood 
movies to make it easy to find the sections they want.

Easy-to-use chapters simplify finding scenes on a DVD.

Give it a try
To copy digital content to a data storage device

1 Plug a data storage device, such as a USB flash drive, into your PC.

2 On the Action Bar, click the Copy menu, and choose To Data Storage 
Device.

3 Drag digital content to the Media Tray, and click Go to setup.

4 Click Start copy.
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Give it a try
To create a DVD menu

1 On the Action Bar, click the Create menu, and choose DVD Disc.

2 On the Create Video Disc page, select a movie style, and click Select 
photos and videos.

3 Drag a folder of video clips to the Media Tray, and click the Go to 
menu editing page.

4 Click the Create chapter point button .

A marker is placed at the beginning of each video clip selected.

5 Click Apply.

6 Click the Simulate disc button .

You can use controls on the remote or click chapter thumbnails in the 
preview window to scroll through the movie. 
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